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Reviewing Hardware Status, DPR Dependency, DPR

Production Timeline, Alarms, and Job Activities


Reviewing Hardware Status 
The Production Monitor reviews hardware status using AutoSys. Hardware status is displayed 
by the AutoXpert HostScape GUI.  By checking the hardware status the Production Monitor can 
determine the status of processors, the condition of the queue, whether any processors are 
overloaded while others are idle, whether there are any system problems, etc. 

HostScape displays jobs on a machine-by-machine basis, indicating which AutoSys server/client 
machines are up and active, and which jobs are running or have recently run on each machine. 
HostScape allows the Production Monitor to check hardware status in real-time. 

The procedure for reviewing hardware status starts with the assumption that the Production 
Monitor has logged in to AutoSys. 

Reviewing Hardware Status 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the HostScape button on the AutoSys GUI Control Panel. 

• The HostScape GUI page (Figure 15) is displayed. 

• View presented is Normal View. 

3	 Review the Control Region (left side of the display) to identify the color codes for the 
status of the machines. In the View Region (right side of the display) the color code is 
displayed on the border of each machine box. 

• MACHINE UP (active) is green. 

• MACHINE DOWN (inactive and cannot be reached) is red. 

•	 MACHINE INACTIVE is black. (The color code is not shown in the Control 
Region) 

4 Review the machine type in the View Region. 

•	 The name of the machine is displayed in the upper left-hand corner of each machine 
box. 

• Server machines are in the first (top) row of the display. 
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• Event Server name appears below the list of jobs, if applicable. 

• Event Processor name appears below the list of jobs, if applicable. 

• Client machines are in the subsequent rows of the display. 

5	 Review the machine boxes in the View Region to determine the status of individual 
machines. 

• The total number of jobs STARTING or RUNNING. 

• All jobs RUNNING are listed. 

• The View Region is scrollable. 

6 Review the Alarm indicating buttons of individual machines in the View Region. 

• Alarm button is in the upper right-hand corner of the box. 

• Red indicates that an alarm has been generated. 

• Gray (default color) indicates normal operation. 

•	 If an alarm is present, clicking an alarm button brings up the Alarm Manager 
(described in a subsequent section). 

7 Review the machine connection status in the View Region. 

•	 Solid black line indicates that AutoSys can communicate with the client machine 
Internet daemon. 

•	 Solid red line indicates that AutoSys cannot communicate with the client machine 
Internet daemon; however, the daemon does respond to ping commands. 

•	 Dashed red line indicates that AutoSys cannot communicate with the client machine; 
the machine is probably turned off. 

8	 Select File → Exit from the pull-down menu then click on the OK button to exit from 
HostScape. 

• HostScape quits (is closed). 

Changing the Hardware Status View 

The View Options provide the Production Monitor with the following three methods of viewing 
hardware status: 

• Normal. 

• Global. 

• Zoom. 
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In the Normal (default) view three rows of machines with job activities are displayed. In the 
Global view seven rows of machines but no job activities are displayed. In the Zoom view one 
machine is displayed in great detail. The details include job name, description, status, and 
commands. 

The Performance Monitor selects the Global view to monitor the entire system and uses the 
Zoom view to focus on a specific machine, especially in case of a malfunction. 

The procedure for changing hardware status views starts with the assumption that AutoSys is 
running in the HostScape mode with the default Normal view displayed. 

Changing Hardware Status Views 

1	 Select a machine in the View Region by clicking on its name, then select 
View → Select View Level → Global View from the pull-down menu. 

• The Global view is displayed. 

• Seven rows of machines are displayed. 

• No job information is displayed. 

2	 Select a specific machine by clicking on its name, then select 
View → Zoom in Machine from the pull-down menu. 

• The Zoom view is displayed. 

•	 A table listing the following data is displayed: 

 Job Name. 

 Description. 

 Status. 

 Command. 

3 Select Dismiss. 

• The Global view is displayed. 

4 Select View → Select View Level → Normal View from the pull-down menu. 

• The Normal view is displayed. 

• Three rows of machines are displayed. 

• Limited job information is displayed. 
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Reviewing DPR Dependencies 
The Production Monitor reviews DPR dependencies using AutoSys. DPR dependencies are 
displayed by the AutoXpert JobScape GUI. 

JobScape presents a Pert-like view of job processing from a logical (or job dependency) point of 
view. JobScape depicts all job types; i.e., command jobs, box jobs, and file-watcher jobs. In 
addition, it depicts the nesting of jobs within boxes and the dependencies between jobs. 

JobScape can be used for monitoring job flow in real-time.  It allows the Production Monitor to 
identify potential problems, try to prevent them from becoming actual problems, stop problem 
jobs in favor of letting good jobs run, etc. 

AutoSys defines job status in the terms listed in Table 2. The different states are color-coded on 
the JobScape display. However, the codes can be changed. The color codes listed in the table 
are the default values. 

Table 2. Job States 
Status Color Code Meaning 

ACTIVATED white The top-level box that the job is in is now in the “running” state but the 
job itself has not started yet. 

STARTING forest green The Event Processor has initiated the start procedure with the Remote 
Agent. The job is in the process of “coming up.” 

RUNNING green The job is running. If the job is a box job, “running” means that the jobs 
within the box may be started (other conditions permitting). If the job is a 
command job or a file-watcher job, “running” means that the process is 
actually running on the remote machine. 

SUCCESS light blue When the job had completed running, it had an exit code equal to or less 
than the “maximum exit code for success.” By default, only the exit code 
“0” is interpreted as “success.” However, a range of values up to the 
“maximum exit code for success” may be reserved for each job to be 
interpreted as success. If the job is a box job, “success” means that all 
jobs within the box had exit codes indicating “success” (default) or the 
“exit condition for box success” was “true.” 

FAILURE red When the job had completed running, it had an exit code greater than 
the “maximum exit code for success.” The default is any non-zero exit 
code. If the job is a box job, “failure” means that at least one job within 
the box had an exit code greater than zero (the default meaning) or the 
“exit condition for box failure” was “true.” 

TERMINATED red The job terminated while in the “running” state. Termination may be the 
result of a user sending a “killjob” event, or a job may have been 
terminated because the job itself (or the box it is in) failed. If the job itself 
fails, it has a “failure” status rather than a “terminated” status. 

RESTART orange The job was unable to start due to hardware or application problems and 
has been scheduled to restart. 
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Table 2. Job States 
Status Color Code Meaning 

QUE_WAIT yellow The job can logically run (i.e., all starting conditions have been met); 
however, there are not enough machine resources available to allow it to 
run. 

ON_ICE black The job is removed from all conditions and logic but is still defined to 
AutoSys. Operationally it is as though the job had been deactivated. 
The job remains “on_ice” until it receives the “job_off_ice” event. 
Downstream dependent jobs behave as though the “on_ice” job ran 
successfully. A job that is “starting” or “running” cannot be put “on_ice.” 

ON_HOLD black The job is on hold and will not run until it receives the “job_off_hold” 
event. Downstream jobs will not run until the job is taken off hold. A job 
that is “starting” or “running” cannot be put “on_hold.” 

INACTIVE white The job has not yet been processed. Either the job has never been run 
or its status was intentionally altered to “turn off” its previous completion 
status. 

The procedure for reviewing DPR Dependencies starts with the assumption that the Production 
Monitor has logged in to the Production Workbench. 

Reviewing DPR Dependencies 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the JobScape button on the AutoSys GUI Control Panel. 

• The JobScape GUI page (Figure 17) is displayed. 

3	 Review the Control Region (left side of display) to identify the True/False dependency 
legend. 

•	 True is indicated by a solid arrow, which indicates that job dependencies have been 
met. 

 The solid arrow is the default code for True; the codes can be changed. 

•	 False is indicated by a dashed arrow, which indicates that job dependencies have not 
been met. 

•	 Dependency arrows indicate only that a job dependency exits for a job. They do not 
define time-related starting conditions, nor do they describe the type of job 
dependency, e.g., “success,” “failure,” or “running.” 
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4 Review the Job Display to determine the status (color-coded) of DPRs. 

• Default colors representing job statuses are listed in Table 2. 

5 Review the Job Display to determine the types of jobs: 

• Rectangle = Box Job. 

• Ellipse = Command Job. 

• Hexagon = File Watcher Job. 

6	 Select a job (for which descendants are to be determined) by placing the mouse cursor on 
the job and clicking with the left mouse button. 

• Color of the border around the selected job changes to yellow. 

• Name of the job appears in the Current Job Name area of the Control Region. 

7	 Review the job’s descendants by placing the mouse cursor on the job and clicking and 
holding the right mouse button. 

• Descendants pop-up menu appears. 

• Color of the border around the selected job changes to yellow. 

• Name of the job appears in the Current Job Name area of the Control Region. 

8	 Select (highlight) Show Children from the Descendants pop-up menu (release the right 
mouse button). 

• Job’s first-level Command, File-Watcher, and Box Jobs appear. 

• Repeat Step 6 to select a different job. 

9 Select Show All Descendants from the Descendants pop-up menu. 

• Job’s Command, File-Watcher, and Box Jobs appear for all levels. 

10 Select Hide All Descendants from the Descendants pop-up menu. 

• Default view is displayed. 

• All descendants are hidden. 

11	 Select File → Exit from the pull-down menu then click on the OK button to exit from 
JobScape. 
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Reviewing the DPR Production Timeline 
The Production Monitor reviews the DPR Production Timeline using AutoXpert TimeScape. 

TimeScape presents a Gantt-like view of a job processing from a temporal (time-related) point of 
view. TimeScape depicts all job types; i.e., Command Jobs, Box Jobs, and File Watcher Jobs. It 
also depicts the nesting of jobs within boxes and the duration of time it will take for jobs to 
complete. TimeScape is used for monitoring job flow in real-time. 

The procedure for reviewing the DPR production timeline starts with the assumption that the 
Production Monitor has logged in to the system. 

Reviewing the DPR Production Timeline 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the TimeScape button on the AutoSys GUI Control Panel. 

• The TimeScape GUI page (Figure 16) is displayed. 

• Current time is displayed in red in the View Region (right side of the display). 

3	 Review the Control Region (left side of display) to identify the Actual/Projected legend 
for making comparisons in the View Region. (Refer to Figure 19.) 

• Projected is a rectangular (blue filled) graphic, to show average job completion time. 

•	 Actual is a striped (white and blue) ribbon, to show how much of the job has 
completed. 

 If there is a green stripe, the job is running. 

 If there is a black stripe, the job has been completed. 

4	 Review a job’s descendants by placing the mouse cursor on a job and clicking and 
holding the right mouse button. 

• Descendants pop-up menu appears. 

• An asterisk (*) indicates that a Box Job’s descendants have been hidden. 

5	 Select (highlight) Show Children from the Descendants pop-up menu and release the 
mouse button. 

• Job’s first-level Command, File Watcher, and Box Jobs appear. 

• Return to Step 4 to select a different job. 

• Go to Step 6 to change the view. 
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6	 Select (using the right mouse button) Show All Descendants from the Descendants pop­
up menu. 

• Job’s Command, File Watcher, and Box Jobs appear with all levels. 

7	 Select (using the right mouse button) Hide All Descendants from the Descendants pop­
up menu. 

• Default view is displayed. 

• All descendants are removed. 

8	 Select File → Exit from the pull-down menu then click on the OK button to exit from 
TimeScape. 

Actual 

Projected 

Actual 

Looks Good! 

Trouble! 

Good vs Bad 

Projected 

Figure 19. Evaluating Actual versus Projected Job Processing Time 
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Reviewing Alarms 
Alarms indicate problems with job processing. They may involve a failure of job processing, a 
database problem, a communications problem, hardware or software failure or some other error 
in the data processing system. 

The Production Monitor reviews alarms using the AutoSys Alarm Manager. The Alarm 
Manager allows the Production Monitor to perform the following functions: 

• View alarms as they arrive. 

• Provide a response to an alarm. 

• Change alarm status. 

The Production Monitor can configure the Alarm Manager to display certain types of alarms 
only. The Production Monitor may wish to see only certain types of alarms (e.g., job failure 
alarms) or only those alarms that are open (have not yet been acknowledged) or only the alarms 
that have occurred within the last thirty minutes. 

The Production Monitor can select alarms to be displayed based on any or all of the following 
three criteria: 

• Type of alarm 

• Alarm state 

• Time of the alarm 

The procedure for reviewing alarms starts from the assumption that the Production Monitor has 
logged in to the system. 

Reviewing Alarms 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the Ops Console button on the AutoSys GUI Control Panel. 

•	 The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 20) is 
displayed. 

3 Click on the Alarm button. 

• The Alarm Manager GUI page (Figure 21) is displayed. 

•	 Alarms are displayed in reverse order of occurrence; i.e., the most recent alarm 
appears at the top of the list. 
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File View 

AutoSys Job Activity Console 

Job Name 

ground_event0 

ground_event2 

ground_event4 

ground_event6 

job0 

job2 

job4 

Currently Selected Job job0 

Description 

Command sleep 120 

Start Time 

End Time 

Run Time 00:02:00 Next Start 

11/08 09:01:02 

11/08 08:59:02 Status SUCCESS Machine osprey Priority 

Exit Code 0 Queue Name osprey Num. of Tries 

Starting Conditions Job Report 

Atomic Condition Current State 

job1 

job3 

ground_event1 

ground_event3 

ground_event5 

ground_event7 

Actions 

On Hold 

Off Hold 

Send EventForce Start Job 

Kill Job 

Start Job Job Definition 

Show 

Dependent Jobs 

Freeze Frame 

Summary 

Reports 

Event 

None Exit 

Alarm 

| Machine Command Status Description 

osprey sleep 120 SUCCESS 

hatteras sleep 120 SUCCESS 

windjammer sleep 120 SUCCESS 

hatteras sleep 120 SUCCESS 

osprey sleep 120 SUCCESS 

heron sleep 120 SUCCESS 

osprey sleep 120 SUCCESS 

T/F 

windjammer sleep 120 SUCCESS 

windjammer sleep 120 SUCCESS 

heron sleep 120 SUCCESS 

osprey sleep 120 SUCCESS 

osprey sleep 120 SUCCESS 

heron sleep 120 SUCCESS 

Figure 20. Job Activity Console (Ops Console) GUI 
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Alarm Manager 

View Options 

Alarm Type 

JOBFAILURE 

JOBFAILURE 

Currently Selected Alarm 

Response 

Alarm State 

Open 

Acknowledged 

Closed 

User Autosys@osprey 

Select JobFreeze Frame New Alarm 

CancelApplyOK 

Comment State Time Job Name 

Open 10/23 08:50:05 execute.ceres4aF 

Open 10/23 08:50:05 execute.ceres4aF 

Figure 21. Alarm Manager GUI 
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• The following information is displayed: 

 Alarm Type. 

 Job Name. 

 Time. 

 State. 

 Comment. 

4 Click on an alarm in the Alarm List. 

• Alarm is displayed in detail in the Currently Selected Alarm region of the display. 

5	 Click the Response edit box and type in a response, if desired, then press the Tab key on 
the keyboard. 

• Response is entered. 

6	 Update the Alarm State by clicking on whichever of the following radio buttons 
appropriately describes the Alarm State: 

• Open. 

• Acknowledged.


• Closed.


The Alarm State is updated.


7	 Click on the Apply button. 

• The alarm response is entered. 

8	 Repeat Steps 4 through 7 to review and update multiple alarms. 

• Alarms are updated/reviewed. 

9 When no more alarms are to be reviewed, click on the OK button. 

• Alarm Manager quits (is closed). 

• Job Activity Console (Ops Console) GUI is displayed. 

10	 To exit from the Job Activity Console (Ops Console) GUI click on the Exit button then 
on the OK button. 

By configuring the AutoSys Alarm Manager the Production Monitor can control which alarms 
are displayed. Alarms can by selected by type, state, or time. 

The procedure for configuring the Alarm Manager starts from the assumption that the Alarm 
Manager is currently running. 
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Configuring Alarm Selection 

1	 Select View → Select Alarms from the pull-down menu. 

• Alarm Selection GUI (Figure 22) is displayed. 

• Alarm Selection has the following defaults: 

 All Types for Select by Type.


 Open and Acknowledge for Select by State.


 All Times for Select by Time.


Figure 22. Alarm Selection GUI 
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2	 To select a single type of alarm, click on the desired alarm in the Select by Type alarm 
list; to select all types of alarms, click on the All Types button. 

• Desired alarm type is selected. 

• If All Types are selected, the All Types button color changes to yellow. 

3	 To select multiple types of alarms: press and hold the Control (Ctrl) key on the 
keyboard while clicking the desired alarms in the Select by Type alarm list. 

• Multiple alarms are selected. 

4	 To select all alarm states click on the All States button; to select alarms by state click on 
whichever of the following Select by State toggle buttons properly describe(s) the 
state(s) to be selected: 

• Open. 

• Acknowledge. 

• Closed. 

Any or all of the buttons in the preceding list can be selected. 

• The color of selected button(s) change(s) to yellow. 

5	 To select all times click on the All Times button; to select alarms by time type the 
starting date (in MM/DD/YY format) in the From Date field and press the Tab key on the 
keyboard to advance to the next field. 

• Starting date is entered. 

• If All Times have been selected, proceed to Step 9. 

6	 Type the starting time (in hh:mm format) in the From Time field and press the Tab key 
on the keyboard to advance to the next field. 

• Starting time is entered. 

7	 Type the end date (in MM/DD/YY format) in the To Date field, and press the Tab key on 
the keyboard to advance to the next field. 

• End date is entered. 

8 Type the end time (in hh:mm format) in the To Time field. 

• End time is entered. 

9 Click on the Apply button. 

• Selections are applied without dismissing (closing) the Alarm Selection GUI. 

•	 This step can be skipped if the OK button is going to be clicked to dismiss the Alarm 
Selection GUI. 
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10 Click on the OK button. 

• Alarm selections are applied. 

• Alarm Selection GUI is closed. 

• Alarm Manager GUI is displayed. 

11 If alarm sound is desired, select Options → Sound On from the pull-down menu. 

• Sound On toggle button is yellow when the sound is on. 

12	 If no alarms are to be reviewed, click on the OK button to exit from the Alarm Manager 
GUI. 

• Alarm Manager quits (is closed). 

• Job Activity Console (Ops Console) GUI is displayed. 

Reviewing Job Selection Criteria 
The Production Monitor reviews job activities using the AutoSys Job Activity Console as 
described in the next section of this lesson. The AutoSys Job Selection GUI is used for 
specifying (filtering) the jobs to be reviewed, including setting the criteria for displaying jobs by 
name, status and/or machine. 

The procedure for reviewing job selection criteria starts from the assumption that the Production 
Monitor has logged in to the system. 

Reviewing Job Selection Criteria 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the Ops Console button on the AutoSys GUI Control Panel. 

•	 The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 20) is 
displayed. 

3 Select View → Select Jobs from the pull-down menu. 

• The Job Selection GUI (Figure 23) is displayed. 

• Job Selection has the following default values: 

 All Jobs/Job Name for Select by Name. 

 All Statuses for Select by Status. 
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 All Machines for Select by Machine. 

 Unsorted for Sort Order. 

Figure 23. Job Selection GUI 
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4	 For the Select by Name option select all jobs by clicking on the All Jobs button. 
Alternatively, to select a particular job by name, type the name of the desired job in the 
Job Name field; to select a particular box by name, type the name of the desired box in 
the Box Name field then type in the Box Levels field how many levels of nesting you 
want to view for the box job. 

• Desired job selection is made. 

•	 When typing in either the Job Name field or the Box Name field, the corresponding 
toggle button is automatically turned on. (You do not have to click on the button, just 
start typing in the desired field.) 

•	 The asterisk (*) wildcard character can be used for entering a partial job or box name 
(e.g., *.ceres*) 

• In the Box Levels field any valid positive integer can be entered or the word “all.” 

 	0 - indicates that only the top-level box specified in the Box Name field is to 
be displayed. 

 	1 - indicates that the specified top-level box and all direct descendant boxes 
and enclosed jobs are to be displayed. 

 all - indicates that all jobs in the box are to be displayed. 

• If All Jobs are selected, the All Jobs button color changes to yellow. 

5	 To select all job statuses click on the All Statuses button; to select jobs by status click on 
whichever of the following Select by Status toggle buttons properly describe(s) the 
status(es) to be selected: 

• Starting. 

• Running. 

• Success. 

• Failure. 

• Terminated. 

• Restart. 

• Que Wait. 

• Activated. 

• Inactive. 

• On Hold. 

• On Ice. 
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6	 To select all machines click on the All Machines button; to select jobs by the particular 
machine click on the name of the desired machine in the Select by Machine list; to select 
multiple machines, click and hold on the first machine then drag the cursor to the name of 
the last machine to be selected and release the mouse button. 

• Selected machine(s) is (are) highlighted. 

• All Machines button turns yellow if selected. 

7 Click on the desired order in the Sort Order area. 

• The following options are available for Sort Order: 

 Start Time. 

 End Time. 

 Job Name. 

 Job Status. 

 Machine Name. 

 Unsorted. 

8 Click on the Apply button. 

• Selections are applied without dismissing (closing) the Job Selection GUI. 

•	 This step can be skipped if the OK button is going to be clicked to dismiss the Job 
Selection GUI. 

9 Click on the OK button. 

• Job selections are applied. 

• Job Selection GUI is closed. 

• Job Activity Console GUI is displayed. 

•	 Job list based on the new selection criteria is displayed in the Job List region of the 
Job Activity Console. 

10	 When the job activity has been adequately reviewed, click on Exit to quit the Job 
Activity Console display. 

•	 AutoSys Job Activity Console Exit GUI is displayed to confirm the decision to quit 
the display. 

11 Click on the OK button to close the Job Activity Console GUI. 

• AutoSys Job Activity Console GUI quits (is closed). 
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Reviewing Job Activities 
The Production Monitor reviews job activities using AutoSys. The Job Activity Console is the 
primary interface that allows the operator to monitor all jobs that have been defined for AutoSys. 
The Job Selection GUI (described in the preceding section) is used for defining the criteria for 
displaying jobs on the Job Activity Console. 

The procedure for reviewing job activities starts from the assumption that the Production 
Monitor has logged in to the system. 

Reviewing Job Activities 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the Ops Console button on the AutoSys GUI Control Panel. 

•	 The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 20) is 
displayed. 

3 Review the Job List region of the Job Activity Console. 

• The following job characteristics are displayed in a table: 

 Job Name (currently selected job). 

 Description. 

 Status. 

 Command. 

 Machine. 

4	 If the Job List region does not contain the desired job or set of jobs, perform the 
procedure for Reviewing Job Selection Criteria (preceding section of this lesson). 

5	 Click anywhere on a job row in the Job List region to have detailed information for that 
job displayed in the Currently Selected Job region of the display. 

6 Review the data in the Currently Selected Job region of the display. 

•	 The following job details are displayed in the Currently Selected Job region of the 
Job Activity Console: 

 Job name (Currently Selected Job). 

 Description. 

 Command. 
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 Start Time (and date). 

 End Time (and date). 

 Run Time. 

 Status. 

 Exit Code. 

 Next Start. 

 Machine. 

 Queue Name. 

 Priority. 

 Num. of Tries. 

Review the data in the Starting Conditions region of the display. 

• The following job starting conditions are displayed: 

 overall starting conditions (including all atomic conditions). 

 Identification of each Atomic Condition. 

⋅ Current State. 

⋅ T/F (true or false). 

•	 The starting conditions can be useful in determining what “upstream” job may be 
preventing the currently selected job from running. 

•	 An Atomic Condition is one of the most basic components of an overall starting 
condition; for example, if SUCCESS(X) and SUCCESS(Y) define the overall starting 
condition for a job, there are two atomic conditions, one of which is SUCCESS(X) 
and the other of which is SUCCESS(Y). 

•	 The T/F (true/false) flag indicates whether the corresponding atomic condition has 
been satisfied. 

•	 Clicking on one of the Atomic Conditions causes the job associated with that 
condition to become the currently selected job, with its details displayed in the 
Currently Selected Job region of the display.  By checking the atomic conditions, it 
is possible to check the path of upstream dependencies to determine which job (if 
any) is preventing a particular job from running. 

 	Figure 24 shows how atomic conditions relate to job dependencies as displayed 
using JobScape. (In this case DPR3 and DPR12 are atomic conditions for 
DPR45.) 
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 	Note that clicking on one of the atomic conditions listed on the Job Activity 
Console does not actually cause the JobScape GUI to be displayed. 

109 

Job Console 

Atomic Conditions 

DPR 3 DPR 12 

DPR 45 

True 
(Done) 

False 
(Not Done) 

Nuke’m 

JobScape GUI 

Figure 24. Atomic Conditions and Upstream Dependencies 

In the Reports list click on the type of report to be reviewed then review the report in the 
Job Report region of the display: 

• The following types of reports can be selected: 

 	Summary, which shows the result of the last execution of the job including the 
following types of information: 

⋅ Job Name 

⋅ Last Start 

⋅ Last End 

⋅ Status 

⋅ Run Pri/Xit 

81 456-TP-003-001


8 



82 

 	Event, which lists all events from the last execution of the job including the 
following types of information: 

⋅ Status [Event] 

⋅ Time 

⋅ Ntry 

⋅ EventState 

⋅ ProcessTime 

⋅ Machine 

 None. 

•	 The selected report is displayed. The color of the button corresponding to the 
selected report changes to yellow. 

9	 When the job activity has been adequately reviewed, click on Exit to quit the Job 
Activity Console display. 

•	 AutoSys Job Activity Console Exit GUI is displayed to confirm the decision to quit 
the display. 

•	 Subsequent sections of this lesson describe features that are accessible through the 
Actions and Show regions of the Job Activity Console. 

• Use and configuration of Alarm functions were described in previous sections. 

10 Click on the OK button. 

• AutoSys Job Activity Console GUI quits (is closed). 
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Modifying Job Priority


Job Priority 
It is sometimes necessary to modify the priority of a job. For example, there may be a hardware 
or software problem that reduces the available resources to the point where some jobs are too 
large to be processed. Or it may become evident that due to the volume of large, high-priority 
jobs, some small, low-priority jobs will never be processed unless they are given higher priority. 

Job priorities are assigned using numbers according to the following rules: 

• 1 (one) has the highest priority. 

• Higher-priority jobs (lower numerically) completely block lower-priority jobs. 

 	Prevents situations where a high-priority, resource-intensive job cannot obtain 
enough resources to run because smaller, lower-priority jobs continually grab 
the small amounts of resources available. 

The Production Monitor uses AutoSys when modifying job priority. The procedure for making 
the modification starts from the assumption that the Production Monitor has logged in to the 
system. 

CAUTION 
The only field that may be modified on the Job Definition 
Advanced Features GUI is the Que Priority field. ECS 
cannot disable these GUI features, because AutoSys/ 
AutoXpert is a commercial off-the-shelf (COTS) product. 
Operations personnel will receive training and 
documentation that will provide clear instructions 
concerning the intended use of the Job Definition 
Advanced Features GUI and which features must be 
avoided. 

Modifying Job Priority 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the Job Definition button. 

• The Job Definition  GUI page (Figure 25) is displayed. 
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Figure 25. Job Definition GUI 
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3 Type the name of the job with the priority to be modified in the Job Name field. 

•	 If necessary, you can select the name of the job from the list of all jobs in the 
database by typing the % wildcard character in the Job Name field, clicking on the 
Search button, and double-clicking on the appropriate job in the pop-up Selection 
List window. 

4 Click on the Adv Features button. 

• The Job Definition Advanced Features GUI (Figure 26) is displayed. 

5	 In the Command Information area of the Job Definition Advanced Features GUI, 
click in the Que Priority field and type in the desired priority value. 

•	 Remember that the only field you may change on the Job Definition Advanced 
Features GUI is the Que Priority. 

6 Click on the Save&Dismiss button. 

• The modified Que Priority value is saved. 

• The Job Definition GUI (Figure 25) is displayed. 

7 Click on the Exit button to quit the Job Definition GUI. 
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Figure 26. Job Definition Advanced Features GUI 
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Modifying Job Status


Job Status 
At times the Production Monitor may need to modify a particular job in any of the following 
ways: 

• Start the job. 

• Kill the job. 

• Force the job to start. 

• Place the job on hold. 

• Take the job off hold. 

The Production Monitor can initiate the preceding actions from the Actions region of the Job 
Activity Console (Ops Console), Figure 20. Those actions and the following additional actions 
can be initiated from the Send Event GUI: 

• Change the job’s status. 

• Change the job’s priority. 

• Put the job on ice. 

• Take the job off ice. 

• Stop the demon (stop the Event Processor in an emergency). 

• Set a global value. 

• Send a signal concerning the job. 

• Make a comment (for example, why a job start was forced). 

The Production Monitor uses the AutoSys Send Event GUI to modify job status. The procedure 
starts with the assumption that the Production Monitor has logged in to the system 

CAUTION 
Once an event has been sent from the Send Event dialog, it 
cannot be canceled or modified in any way. 

87 456-TP-003-001




88 

Modifying Job Status 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 

2 Click on the Ops Console button on the AutoSys GUI Control Panel. 

•	 The Job Activity Console GUI, also known as the Ops Console GUI, (Figure 20) is 
displayed. 

3	 Review the Job List region of the Job Activity Console to identify the job with the 
status to be modified. 

4	 If the Job List region does not contain the desired job or set of jobs, perform the 
procedure for Reviewing Job Selection Criteria (described in a previous section). 

5	 In the Job List region of the Job Activity Console click on the job row corresponding to 
the job with the status to be modified. 

6 Click on the Send Event button in the Actions region of the Job Activity Console GUI. 

• The Send Event  GUI (Figure 27) is displayed. 

•	 Send Event has the following default values. 

 Start Job for Event Type. 

 Now for Time. 

 Normal for Send Priority. 

7 Verify that the correct job is listed in the Job Name field of the Send Event GUI. 

•	 If not, click on the Cancel button and select the correct job (perform Steps 3 through 
6). 

8 Click on Event Type to select the desired type of job status to be modified. 

•	 Event Type has the following options. 

 Start Job. 

 Job On Hold. 

 Job Off Hold. 

 Comment. 

 Stop Demon. 
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Figure 27. Send Event GUI 
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 Force Start Job. 

 Job On Ice. 

 Job Off Ice. 

 Kill Job. 

 Change Status. 

 Change Priority. 

 Set Global. 

 Send Signal. 

•	 Remember that a job with status of either “starting” or “running” cannot be put “on 
hold” or “on ice.” 

• Note that the GUI has an option to Cancel Previously Sent Event. 

9	 To enter the desired date and time when the job status is to be modified, either right away 
or at some time in the future, click on either Now or Future.  If Future is selected, type 
in the Date (in MM/DD/YY format) and Time (in hh:mm format), and click on either 
A.M. or P.M. 

• Select Now for immediate execution. (Current date and time are default values.) 

• Select Future for a future date and time. 

10 Type any comments in the Comment field. 

•	 Comment is a free-form field for entering text that should be associated with the 
event in the database. 

 For example, explain why the selected “send event” was initiated. 

11 Review the AUTOSERV Instance field. 

•	 Instance field specifies the instance of AutoSys/AutoXpert to which the event will be 
sent. (You can send events to instances of AutoSys/AutoXpert other than the one you 
are running.) 

•	 The current AutoSys/AutoXpert instance should be displayed by default in the 
AUTOSERV Instance field. 

•	 If the event specified in the Event Type field should be sent to a different instance of 
AutoSys/AutoXpert, type the name of the other instance in the AUTOSERV 
Instance field. 
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12 Review the Global Name and Global Value fields. 

•	 Global Name and Global Value are accessible only if Set Global was selected in the 
Event Type region. 

•	 If Set Global was specified in the Event Type field, type the appropriate entries in 
the Global Name and Global Value fields. 

13 Review the Signal field. 

•	 Signal is accessible only if Send Signal or Kill Job was selected in the Event Type 
region. 

•	 If either Send Signal or Kill Job was specified in the Event Type field, type the 
appropriate entries in the Signal field. 

14 Review the Queue Priority entry. 

•	 Queue priority can be changed only if Change Priority was selected in the Event 
Type region. 

•	 If the queue priority is to be changed, type the new priority in the Queue Priority 
field. 

15 Review the Status option menu. 

• Status can be changed only if Change Status was selected in the Event Type region. 

•	 Click on the Status button and select (from the pick-list) the job status to which the 
job should be changed. 

•	 Status has the following options. 

 Running. 

 Success. 

 Failure. 

 Terminated. 

 Starting. 

 Inactive. 

16 Review the Send Priority radio buttons. 

•	 Send priority can be changed only if Send Priority was selected in the Event Type 
region. 

•	 If the send priority is to be changed, click on the button corresponding to the desired 
send priority. 
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• Send Priority has the following options. 

 Normal. 

 High. 

• High priority is reserved for emergencies. 

17 Click on the Execute button then click on the Yes button to enable the modified event. 

• Job Activity Console (Ops Console) GUI is displayed. 

•	 Once an event has been sent from the Send Event dialog, it cannot be canceled or 
modified in any way. 
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Reviewing Activity and Job Dependency Logs


Reviewing an Activity Log 
The Production Monitor reviews the activity log to obtain the following types of information: 

• which jobs have been completed. 

• which jobs are currently running. 

• which jobs are in the queue. 

The Production Monitor reviews the activity log using the AutoSys AutoRep command. The 
AutoRep command reports information about a job, jobs within boxes, machines, and machine 
status. Figure 28 shows a sample activity log. 

-------------------------------------< Date: 06/14 

EVENT: CHANGE_STATUS STATUS: JOB: stage.DPR_04 

EVENT: CHANGE_STATUS STATUS: JOB: stage.DPR_04 

EVENT: CHANGE_STATUS STATUS: JOB: stage.DPR_04 

-------------------------------------< Date: 06/14 

EVENT: CHANGE_STATUS STATUS: JOB: prepare.DPR_08 

EVENT: CHANGE_STATUS STATUS: JOB: prepare.DPR_08 

EVENT: CHANGE_STATUS STATUS: JOB: prepare.DPR_08 

>-----------------------------21:52:04 

STARTING 

RUNNING 

SUCCESS 

>-----------------------------21:53:04 

STARTING 

RUNNING 

SUCCESS 

Figure 28. Sample Activity Log 

The procedure starts with the assumption that the Production Monitor has logged in to the 
system. 
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Reviewing an Activity Log 

NOTE: Commands in Steps 1 through 10 are typed at a UNIX system prompt. 

1	 Access the command shell. 

• The command shell prompt is displayed. 

2 Type xhost + then press the Return/Enter key on the keyboard. 

3 Open another UNIX window. 

4	 Start the log-in to the planning server by typing either telnet servername (e.g., 
plnn1sun), rlogin servername, or rsh servername in the second window then press the 
Return/Enter key. 

• If you use the telnet command, a Login: prompt appears; continue with Step 5. 

•	 If you use either the rlogin or rsh command, the system uses the User ID currently in 
use; go to Step 6. 

5	 If a Login: prompt appears, log in as yourself by typing your UserID then pressing the 
Return/Enter key. 

6 At the Password: prompt type your Password then press the Return/Enter key. 

7 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 

•	 It is recommended that you use the terminal/workstation IP address instead of the 
machine-name for the clientname. 

8 Type cd /path then press Return/Enter. 

•	 Change directory to the directory (e.g., /home/kummerer/ssit/AutoSys) containing the 
AutoSys set-up file (i.e., Autosys_Setup.com). 

9 Type source Autosys_Setup.com then press Return/Enter. 

• The source command sets the environment variables. 

10	 Type autorep -J ALL unless the command needs to be modified in one of the following 
ways: 

• The particular path to be typed may vary from site to site. 

• To specify a particular job, type the job name instead of ALL. 

•	 To obtain a machine report, type -M machine_name after either ALL or the job 
name. 

• To obtain a summary report, type -s after either ALL or the job name. 

• To obtain a detailed report, type -d after either ALL or the job name. 
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• To obtain a query report, type -q after either ALL or the job name. 

•	 To print the document, type | lpr after typing the code for whichever of the preceding 
options are desired. 

11 Press the Return/Enter key on the keyboard to obtain access to the Activity Log. 

• The Activity Log (Figure 28) is displayed. 

• If | lpr was typed on the command line, the Activity Log is printed. 

12 Review the Activity Log to determine job states. 

• Completed. 

• Currently running. 

• In the queue. 

Reviewing a Job Dependency Log 
The Production Monitor reviews a job dependency log using the AutoSys job_depends 
command. The job_depends command reports information about the dependencies and 
conditions of jobs. The command can be used for determining the current state of a job, its job 
dependencies, the dependencies and nested hierarchies (for boxes) as specified in the job 
definition, and a forecast of what jobs will run during a given period of time. 

The procedure starts with the assumption that the Production Monitor has logged in to the 
system. 

Reviewing a Job Dependency Log 

1	 Set up AutoSys as described in Steps 1 through 9 of the procedure for Reviewing an 
Activity Log. 

2	 Type  job_depends -c -J ALLunless the command needs to be modified in one of the 
following ways: 

• The particular path to be typed may vary from site to site. 

• To specify a particular job, type the job name instead of ALL. 

• To obtain the current condition status, type -c before -J. 

• To obtain the dependencies only, type -d before -J. 

• To obtain the time dependencies, type -t before -J. 

•	 To print the document, type | lpr after typing the code for whichever of the preceding 
options are desired. 
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3 Press the Return/Enter key on the keyboard to obtain access to the Activity Log. 

• The Job Dependency Log (Figure 29) is displayed. 

• If | lpr was typed on the command line, the Job Dependency Log is printed. 

Job Name Status Date Cond? Start Cond? Dependent Jobs? 

DPR## Activated  No

 F SUCCESSEXIT_CODE(execute.DPR_##) 

 T SUCCESSSUCCESS(SPR_##) 

T/F 

 Yes  No 

Condition: 

Atomic Condition 

(success(DPR_##) and exit code(execute.DPR_##)<5) 

Current Status 

Figure 29.  Sample Job Dependency Log 

Review the Job Dependency Log to determine job status, including the status of atomic 
conditions. 
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Generating Production Reports


Production Reports 
Members of the Production Team can generate several different types of reports. The method 
used depends on the type of report desired. For example, the Report Generator GUI allows the 
Production Team to select from a variety of standard reports, including the following types of 
reports: 

• Processing Status Report. 

• Processing Errors Report. 

• Resource Usage Report. 

• Actual vs. Plan Report. 

• Ground Event Resource Utilization Report. 

• Ground Event Resource Schedule (by resource) Report. 

• Ground Event Resource Schedule (Chronological) Report. 

• Job Report. 

• Dependency Jobs Report 

• Disk Availability Report. 

• Production Plan Report. 

Other reports can be generated from the Monitor/Browser GUI. AutoSys also has the capability 
of generating Job Reports, Machine Reports, and Reports on AutoSys Global Variables being 
used. 

Processing Status Report - Provides status of production requests (PRs) for a specified 
instrument and a specified period. PRs are included in the report if they had Data Processing 
Requests (DPRs) run during the reporting time period, or if PRs are currently active within the 
DAAC plan. The reporting periods for which status is determined are one (1) day (current) and 
three (3), seven (7), 30, and 90 days in the past. The one-, three-, and seven-day reports are 
updated daily, while the 30- and 90-day reports are updated weekly. There is one set of 
Processing Status Reports per instrument per DAAC. 

Processing Errors Report - Provides error status from all failed DPRs during one day grouped 
by PR, and summaries for the preceding three (3), seven (7), 30 and 90 days. The report is 
produced daily. There is one Processing Errors Report per instrument per DAAC. 
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Actual vs. Plan Report - The report compares the active production plan with the current 
processing status at the product group, product, and PGE level, and gives an account of 
production backlogs. 

Ground Event Resource Usage Report - The report summarizes the resource usage for the day. 
In addition, comparisons for the average of resource usage from the successful DPRs for the 
preceding seven (7) and 30 days are also produced daily. 

Ground Event Resource Schedule Report - The report summarizes the scheduling of 
resources. 

The procedure for generating standard production reports starts with the assumption that the 
Production Planner or Monitor has logged in to the system. 

Generating Standard Production Reports 

1	 Launch the Production Request Editor as described in Steps 1 through 10 of the 
procedure for Creating a New Production Request. 

• The Production Request Editor Introductory GUI (Figure 2) is displayed. 

2	 Access the Report Generator GUI by selecting File → Generate Report from the pull­
down menu. 

• The Report Generator GUI (Figure 30)is displayed. 

3 Click and hold on the Report option button to display a menu of reports. 

•	 The following menu of reports is displayed: 

 Processing Status Report. 

 Processing Errors Report.


 Resource Usage Report.


 Actual vs. Plan.


 Ground Event Resource Utilization.


 Ground Event Resource Schedule (by resource).


 Ground Event Resource Schedule (Chronological).


 Job Report.


 Dependency Jobs Report.


 Disk Availability Report.


 Production Plan Report.
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Figure 30. Report Generator GUI 
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4	 Select the desired report by moving the cursor to the desired report in the menu to 
highlight it, then release the mouse button. 

• Selected type of report appears on the Report option button. 

• Report fields appear in the Report Selection area. 

5	 Enter (type/select) report parameters in the fields that appear in the Report Selection 
area (if applicable). 

• Parameters vary with the type of report selected. 

 	No parameters (Ground Event Resource Utilization Report or Disk Availability 
Report). 

 	Instrument, Days (Processing Status Report, Processing Errors Report, 
Resource Usage Report, Actual vs. Plan Report). 

 	Start Date, End Date (Ground Event Resource Schedule Report (by Resource), 
Ground Event Resource Schedule Report (Chronological)). 

 Name, Start Date, End Date (Production Plan Report). 

 DPR I.D. (Job Dependency Report). 

•	 To select options for fields that have options (i.e., Instrument, Days) click and hold 
the option button for the field to display a menu from which values (e.g., CERES or 
LIS; 1, 7, 30, 90) can be chosen. 

6	 Click and hold the Destination option button to display a menu of destinations (output 
options). 

•	 The following menu of destinations is displayed: 

 Display is the default and is always selected. 

 Printer will send the file to the selected printer. 

 Data Document Server will save the file to the Document Data Server. 

 File will save the file in a specified directory (selected in the next step). 

7	 Select the desired destination by moving the cursor to the desired destination in the menu 
to highlight it, then release the mouse button. 

• Selected destination appears in the Destination field. 

8	 If File was selected in Step 7, either type the report file destination (path/filename) in the 
Report File field or use the browse tool (Browse… button) to select/identify the file. 

9 Click on the Apply button to generate the report. 

• The report is generated. 

• Report appears in the Report area of the GUI. 
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• File is printed, if Printer was selected in Step 7. 

•	 File is saved to the document data server if Data Document Server was selected in 
Step 7. 

• File is saved to the specified local directory if File was selected in Step 7. 

10	 When the report has been adequately reviewed on the screen, click on the Cancel button 
to close the GUI. 

• Report Generator GUI is closed. 

The procedure for generating AutoSys reports (e.g., about a job, job within boxes, machines, and 
machine status, along with reports on global variables) starts with the assumption that the 
Production Planner or Monitor has logged in to the system. 

Generating AutoSys Reports 

1	 Set up AutoSys as described in Steps 1 through 9 of the procedure for Reviewing an 
Activity Log. 

2	 If a Detailed Job Report is desired, type autorep -J job_name  -d then press the 
Return/Enter key on the keyboard. 

• Detailed Job Report is displayed. 

• To specify all jobs type ALL instead of job_name. 

•	 Refer to the AutoSys User Manual for descriptions of all options and displays for all 
reports. 

3	 If a Summary Job Report is desired, type autorep -J job_name  -s then press the 
Return/Enter key on the keyboard. 

• Summary Job Report is displayed. 

• To specify all jobs, type ALL instead of job_name. 

•	 Refer to the AutoSys User Manual for descriptions of all options and displays for all 
reports. 

4	 If a Machine Report is desired, type autorep -M machine_name then press the 
Return/Enter key on the keyboard. 

• Machine Report is displayed. 

• To specify all machines type ALL instead of machine_name. 

•	 Refer to the AutoSys User Manual for descriptions of all options and displays for all 
reports. 
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5	 If an AutoSys Global Variables Report is desired, type autorep -G global_name then 
press the Return/Enter key on the keyboard. 

• AutoSys system configuration parameters are displayed. 

• To specify all global variables type ALL instead of global_name. 

•	 Refer to the AutoSys User Manual for descriptions of all options and displays for all 
reports. 

6 Review the report. 
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Defining and Running Monitors/Browsers


Defining Monitors/Browsers 
The Production Monitor uses the AutoSys Monitor/Browser to define monitors and browsers. 
Although some Production Monitors may wish to monitor all events, it is more likely that they 
will prefer to limit monitoring to alarms and changes of job status (e.g., from “running” to 
“success” or “failure”). They use the browser function to determine such things as the current 
status of a particular job or which jobs presently have a particular status (e.g., which jobs, if any, 
are on hold). 

Alarm: STARTJOBFAIL 

Exit Code = 0 

Job: execute.DPR_15 FAILURE 

<Have EXCEEDED the Max # of times (10) to attempt a restart. 
wrong and needs to be investigated> 

Alarm: STARTJOBFAIL 

Exit Code = -655 

Run #782:9 19:18:18 06/14 Job: execute.DPR_15 

19:20:20 Run # 782 06/14 

Something is 

Run #782:9 19:18:18 06/14 Job: execute.DPR_15 

Figure 31. Sample Browser Screen 

The procedure for defining monitors or browsers starts with the assumption that the Production 
Monitor has logged in to the system. 

Defining Monitors/Browsers 

1	 Launch AutoSys as described in Steps 1 through 10 of the procedure for Configuring 
AutoSys Runtime Options. 

• The AutoSys GUI Control Panel (Figure 14) is displayed. 
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2 Click on the Monitor/Browser button on the AutoSys GUI Control Panel. 

• The Monitor/Browser GUI (Figure 32) is displayed. 

3 Type a name for the monitor or browser in the Name field near the top of the GUI. 

• Name must be in valid file-name format. 

•	 If a pre-defined monitor or browser is desired, use the Search button under the Name 
field to call it up. 

4 Click on either the Alarms button or the ALL EVENTS button for Types of Events. 

5	 Click on either ALL Job Status Events or the corresponding toggle button(s) to select 
individual Job Status Events. 

•	 Any or all of the following Job Status Events can be selected: 

 Running. 

 Success. 

 Failure. 

 Terminated. 

 Starting. 

 ReStarting. 

 On Ice. 

 On Hold. 

6 Click on the corresponding toggle button to select the desired Job Selection Criteria. 

• Job selection criteria options are as follows: 

 All Jobs. 

 Box with its Jobs. 

 Single Job. 

• If Single Job is selected, type the job name in the Job Name field. 

7 Click on the corresponding toggle button to select the desired Monitor Options. 

•	 Monitor Options refers to one of the following choices: 

 Sound. 

 Verification Required for Alarms. 

104 456-TP-003-001




166

105 

Figure 32. Monitor/Browser GUI 
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8	 Click on Yes or No to select the desired Current Run Time and/or Events After Date/ 
Time, which are the Browser Time Criteria. 

•	 If Events After Date/Time are desired, type the starting date and time (in 
MM/DD/YY hh:mm formats) in the Events After Date/Time field. 

9 Click on the corresponding toggle button to select the desired Mode. 

•	 The following options are available: 

 Monitor. 

 Browser. 

• If Monitor is selected, settings are defined for a monitor. 

• If Browser is selected, settings are defined for a report. 

10 Click on the Save button. 

• The monitor or browser definition is saved to the database. 

•	 Before running a monitor or browser you must Save the monitor/browser definition 
first. 

11 Click on the Run MonBro button to run the monitor/browser that has just been defined. 

12 Review the monitor/browser results. 

13 Type Ctrl-C to exit from a browser. 

Running Monitors/Browsers 
There are two procedures for running monitors/browsers. Monitors/browsers may be run from 
the Monitor/Browser GUI as described in the preceding procedure or they may be run using a 
UNIX command. In either case, the procedure starts with the assumption that the Production 
Monitor has logged in to the system. 

Running Monitors/Browsers 

1	 Set up AutoSys as described in Steps 1 through 9 of the procedure for Reviewing an 
Activity Log. 

2	 Type monbro -N name  & then press the Return/Enter key on the keyboard to run the 
previously defined monitor/browser. 

•	 The monitor or report (browser) must have been previously defined and saved under 
an appropriate file name using the Monitor/Browser GUI. 

• The report is displayed. 
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• Refer to the AutoSys User Manual for all options and displays for all monbro reports. 

3 Review the monitor/browser results. 

4 Type Ctrl-C to exit from a browser. 
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Changing the Database Maintenance Time


Database Maintenance Time 
Once a day the Event Processor goes into an internal database maintenance cycle. During this 
time, it does not process any events and it waits for the maintenance activities to be completed 
before resuming normal operations. The time of day for start-up of the maintenance cycle is pre­
set to 3:30 AM. The database maintenance cycle takes approximately one minute.  If it is 
necessary to change the time when the maintenance cycle occurs, the Production Monitor can 
reset it, preferably to a time when there is minimal activity. 

The procedure for changing the database maintenance time starts with the assumption that the 
Production Monitor has logged in to the system. 

Changing the Database Maintenance Time 

1 Access the command shell. 

• The command shell prompt is displayed. 

2 Type xhost + then press the Return/Enter key on the keyboard. 

3 Open another UNIX window. 

4	 Start the log-in to the appropriate server by typing either telnet servername (e.g., 
plnn1sun), rlogin servername, or rsh servername in the second window then press the 
Return/Enter key. 

• If you use the telnet command, a Login: prompt appears; continue with Step 5. 

•	 If you use either the rlogin or rsh command, the system uses the User ID currently in 
use; go to Step 6. 

5	 If a Login: prompt appears, log in as yourself by typing your UserID then pressing the 
Return/Enter key. 

6 At the Password: prompt type your Password then press the Return/Enter key. 

7 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 

•	 It is recommended that you use the terminal/workstation IP address instead of the 
machine-name for the clientname. 

8 Type cd /path then press Return/Enter. 

•	 Change directory to the directory (e.g., /data1/COTS/autotree2) containing the 
config.XXX file (where XXX = the applicable AUTOSERV instance). 

• The particular path to be typed may vary from site to site. 
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9	 Type vi config.XXX (where XXX = the applicable AUTOSERV instance) then press 
Return/Enter. 

• The configuration file is displayed by the vi text editor. 

10	 Using vi editor commands find DBMaintTime=03:30 and replace the existing time with 
the desired time in 24 hour format (hh:mm). 

•	 The time may already have been changed to some value other than 03:30 (e.g., 
DBMaintTime=04:00). 

•	 The following vi editor commands are useful: 

 h (move cursor left) 

 j (move cursor down) 

 k (move cursor up) 

 l (move cursor right) 

 i (insert text) 

 x (delete a character) 

 u (undo previous change) 

 Esc (switch to command mode) 

11 Press the Esc key. 

12 Type ZZ then press Return/Enter. 

• New database maintenance time is entered and saved in the configuration file. 

• UNIX prompt is displayed. 
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Production Processing Scenarios


The following three scenarios from the Operations Scenarios for the ECS Project: Release A, 
605-CD-001-003, June 1996, illustrate production processing: 

• Normal Production Processing Scenario 

• Production Processing Job Anomaly Scenario 

• Production Processing Job Modification Scenario 

Normal Production Processing Scenario 
This scenario occurs during a given day of the Release A period at the Langley Research Center 
(LaRC) DAAC under the following conditions: 

• DAAC is in stable operations. 

•	 The Production Planner sends the next 16-hour portion daily production schedule to 
the Data Processing Subsystem (DPS), representing the processing workload for the 
day. 

Production processing is expected to be a routine event. The Production Monitor monitors the 
daily production schedule at the beginning of each shift and periodically throughout the day. In 
the normal case, the Production Monitor interacts with the system only at the beginning of the 
day and when jobs fail. The loading of a day’s jobs occurs once in each sixteen hour period. 
The activation of the daily production schedule in AutoSys is automatic and does not require 
operator intervention. 

The scenario is based on the following assumptions: 

• The long-term production planning window is one month. 

•	 Each day the production planner sends a sixteen hour portion of the active plan to the 
production processing system. 

 This window is adjustable to suit the needs of the DAAC. 

•	 The scenario represents normal processing and does not investigate various 
anomalies. 

The following steps have been extracted and adapted from the scenario: 

1. 	 The Production Planner notes the jobs scheduled for processing today in the month­
long current active plan. The Production Planner, using the Planning Workbench 
software, initiates the “downloading” of the daily schedule of jobs to the AutoSys 
scheduling tool. 
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•	 The system converts DPRs into AutoSys commands using the AutoSys Job 
Information Language (JIL) interface. 

•	 AutoSys displays each DPR in a job box which contains all the required jobs for 
a PGE. 

•	 AutoSys automatically places the jobs in a “held” state while waiting on their 
data dependencies. 

2. 	 The Data Server Subsystem notifies the Planning Subsystem subscription manager 
software as subscription requests are fulfilled. 

•	 The subscription manager software releases the appropriate DPRs from their 
“held” state as the subscription notifications arrive. 

• This process is automatic and requires no operator intervention. 

3. 	 The Production Monitor may use AutoSys/AutoXpert to observe and determine the 
processing status of all DPRs throughout the day. 

• The AutoXpert JobScape GUI shows job status. 

•	 The Processing Subsystem scheduling engine (AutoSys) dispatches DPRs as 
specified by the subscription manager. 

•	 A typical DPR may contain the following information: 

 Resource Allocation. 

 Data Staging. 

 Environment Preparation. 

 PGE execution. 

 Data Destaging 

 Resource Deallocation. 

• As DPRs finish, their job boxes turn gray. 

4. 	 The Production Monitor views a GANTT-chart view (AutoXpert TimeScape GUI) of 
the daily schedule of jobs. 

5. 	 The Processing Subsystem scheduling engine (AutoSys) stores production history 
data (e.g., duration, completion code) in its database. 

•	 Production planning software uses production history data in creating the next 
daily production schedule. 

At the completion of the preceding scenario, the Planning and Data Processing System (PDPS) 
database contains new and updated entries reflecting the production processing status from the 
current day. The Production Planner will use the information in determining which DPRs to 
include in the next daily production schedule. 
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Production Processing Job Anomaly Scenario 
The Production Processing Job Anomaly Scenario occurs during a given day of the Release A 
period at the LaRC DAAC under the following conditions: 

• The DAAC is in stable operations. 

•	 The daily production schedule for this day has been loaded and PGE execution is in 
progress. 

•	 The Data Processing Subsystem (as managed by the AutoSys Job Scheduling engine) 
runs the PGEs and associated jobs as the resources required for the tasks become 
available. 

This scenario follows a PGE that fails due to an internal software error during execution. The 
scenario follows the PGE execution from AutoSys alarm generation and PGE termination 
through PGE data destaging, notification to the Instrument Team (IT), post-mortem analysis and 
PGE reprocessing. The actors in the scenario are the DAAC Production Monitor, the DAAC 
Data Specialist and the ECS system. 

This scenario addresses anomalies that occur internal to the PGE. Such failures include but are 
not limited to the following factors: 

• missing, bad or incomplete input data. 

• PGE software faults. 

• input or output resource failures. 

• communication errors. 

The scenario does not address re-initiation of the PGE after failure. Each PGE will have 
individual methods for re-initiation, from simple resubmission to specialized command line 
arguments. As this varies widely with the PGE in question it is not addressed here although re­
initiation is an option when a PGE fails. 

Production processing job anomalies are expected to be non routine events. However, job 
anomalies are expected. It is expected that the majority of PGEs run to completion without 
incident. The Production Monitor is alerted to the anomalies that occur and can take the needed 
action. Less than 5% of PGEs should fall into this category. 

The scenario is based on the following assumptions: 

•	 The daily production schedule has been sent from Planning and some of the 
scheduled PGEs are executing. 

• The failed PGE terminates gracefully and returns a status code. 

• No option to re-initiate the PGE exists for the failed PGE. 
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The following steps have been extracted and adapted from the scenario: 

1. 	 The Production Monitor, using the AutoXpert HostScape GUI, notes that a PGE 
completed its execution abnormally. 

•	 The system displays an AutoSys alarm for the failed PGE on the AutoXpert 
HostScape GUI. 

2. 	 The system sends the Management Subsystem (MSS) HP OpenView event for the 
AutoSys alarm. 

• MSS logs the event. 

3. 	 The Production Monitor decides to double-check the failed PGE using the AutoXpert 
TimeScape and JobScape GUIs. 

• The system displays the failed PGE on the TimeScape and JobScape GUIs. 

 	This step is not mandatory; it is presented to demonstrate how the Production 
Monitor can view the problem. 

4. 	 The Production Monitor clicks on the HostScape alarm box and views the detailed 
information concerning the PGE failure. 

• The system displays the AutoSys alarm display for detailed alarm information. 

5. 	 The Production Monitor notifies the responsible DAAC Data Specialist of the PGE 
failure. 

• May send an e-mail message or make a telephone call. 

•	 The Processing Subsystem moves the temporary output and job logs for the 
failed PGE to the local storage on the appropriate data server for destaging. 

6. The Production Monitor opens a trouble ticket on the PGE failure. 

7. 	 The DAAC Data Specialist, coordinating with the Science Computing Facility (SCF), 
reviews appropriate information received from the Production Monitor, makes the 
necessary adjustments to the PGE and resubmits the algorithm through the integration 
and test process. 

At the completion of the scenario, the PDPS database contains new and updated entries 
reflecting the production processing status from the failed job. The data server contains the job 
logs and output data from the PGE. The DAAC Data Specialist has been informed of the 
location of the this data and the detailed alarm information. The DAAC Data Specialist passes 
the information to the Instrument Team. 
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Production Processing Job Modification Scenario 
The Production Processing Job Modification Scenario occurs during a given day of the Release 
A period at the LaRC DAAC under the following conditions: 

• The DAAC is in stable operations. 

•	 The daily production schedule for the day has been loaded and PGE execution is in 
progress although the PGE to be modified has not begun executing. 

•	 The Data Processing Subsystem (as managed by the AutoSys Job Scheduling engine) 
executes the PGEs and associated jobs as the resources required for the tasks become 
available. 

The scenario follows the steps the Production Monitor takes to change the priority of a PGE. 
The scenario follows the PGE from selection to priority change. The actors in the scenario are 
the Production Monitor and the ECS system. 

Note that the job modification (priority change in this scenario) applies to the next execution of 
the PGE only. 

•	 A modification made with the AutoSys interface allows the Production Monitor 
flexibility in controlling the job schedule. 

 No change is reflected in the PDPS database. 

•	 A permanent change is accomplished through the Planning Subsystem GUIs as 
described in the Replanning Production Scenario. 

Production processing job modifications are expected to be non routine events. It is expected 
that the majority of PGEs will not require changes. However the ECS allows the production 
monitor to modify job parameters (such as priority) any time prior to PGE execution. This 
allows flexibility in unforeseen and unusual circumstances. Such circumstances include but are 
not limited to the following conditions: 

• equipment failures. 

• emergency or high priority processing. 

• delayed input data. 

• PGE faults. 

•	 PGEs with data product-dependent components that affect PGE run time (e.g., the 
PGE runs long or short when clouds are encountered). 

• PGEs with geo-location dependent processing. 

The job modification rate is expected to be very low, well under 5%. 

The scenario is based on the following assumptions: 
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•	 The daily production schedule has been sent from Planning and some of the 
scheduled PGEs are executing. 

• The PGE to be modified has not begun execution. 

The following steps have been extracted and adapted from the scenario: 

1. 	 The Production Monitor, using AutoSys, selects a PGE from the Job Activity 
Console GUI and clicks on the Job Definition button. 

• The system displays the Job Definition GUI. 

2. 	 The Production Monitor selects the Job Definition Advanced Features GUI by 
clicking on the Adv Features button on the Job Definition GUI. 

• The system displays the Job Definition Advanced Features GUI. 

3. 	 The Production Monitor changes the priority of the selected PGE and saves the data 
in AutoSys by clicking on the Save&Dismiss button on the Job Definition 
Advanced Features GUI. 

• The system displays the Job Definition Advanced Features GUI. 

4. The Processing Subsystem (AutoSys) updates the job priority of the selected PGE. 

At the completion of the scenario, the AutoSys database entry for the selected PGE has been 
modified as desired. 
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Performing Science Product Quality Assurance


Science Product Quality Assurance 
Science product quality assurance (QA) involves the use of the Q/A Monitor application. The 
Production Monitor’s role in QA is limited to making a visual check to ensure that the output of 
data processing is of the desired type (rather than an empty granule). The Science Data 
Specialist makes a more detailed inspection of the science products. 

The procedure for performing science product QA starts with the assumption that the Production 
Monitor has logged in to the ECS system. 

Performing Science Product Quality Assurance (QA) 

NOTE: Commands in Steps 1 through 10 are typed at a UNIX system prompt. 

1 Access the command shell. 

• The command shell prompt is displayed. 

2 Type xhost + then press the Return/Enter key on the keyboard. 

3 Open another UNIX window. 

4	 Start the log-in to the appropriate server by typing either telnet servername (e.g., 
sprn1sun), rlogin servername, or rsh servername in the second window then press the 
Return/Enter key. 

• If you use the telnet command, a Login: prompt appears; continue with Step 5. 

•	 If you use either the rlogin or rsh command, the system uses the User ID currently in 
use; go to Step 6. 

5	 If a Login: prompt appears, log in as yourself by typing your UserID then pressing the 
Return/Enter key. 

6 At the Password: prompt type your Password then press the Return/Enter key. 

7 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 

•	 It is recommended that you use the terminal/workstation IP address instead of the 
machine-name for the clientname. 

8 Type cd /path then press Return/Enter. 

•	 Change directory to the directory (e.g., /home/kummerer/ssit/QaMonitor) containing 
the QA Monitor set-up file (i.e., QaMonitor_Setup.com). 
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9 Type source QaMonitor_Setup.com then press Return/Enter. 

• The source command sets the environment variables. 

10 Type QAMonitor then press Return/Enter to launch the Q/A Monitor GUI. 

• The Q/A Monitor GUI (Figure 33) is displayed. 

•	 If the Q/A Monitor GUI is unresponsive, check to see if there is a prompt window 
waiting for a response hidden behind the main GUI. 

•	 The operator composes a query so the program can search for the granule(s) to be 
checked. The operator specifies the data type and range of dates to be included in the 
search. 

11	 Verify that the QRU data tab is being displayed. (Click on the QRU data tab if 
necessary.) 

• The Q/A Monitor GUI QRU data tab (Figure 33) is displayed. 

• QRU = Query, Retrieve and Update. 

12 In the Data Types field, click on the data type to be checked. 

• It may be necessary to scroll through the Data Types list. 

• The selected data type is highlighted. 

• Only one data type can be selected at a time. 

• Alternatively, the Find field and button can be used for specifying a data type. 

 The Find field is case-sensitive. 

13	 Click in the appropriate Duration window field(s) and either type or use the up/down 
arrow buttons to enter the Begin Date and End Date in MM/DD/YYYY format. 

•	 In the Duration window it is necessary to specify the range of dates (between the 
Begin Date and the End Date) to formulate a query for searching for the desired 
granule(s) to be checked. 

•	 Time is based upon day of insert into the data server. If no dates are entered, an error 
message is displayed. 

•	 The up and down arrows next to the duration fields may be used for modifying entries 
in each field. 

• The Tab key may be used to move from field to field. 

14 Click on the Query button. 

• File Names within the specified date range appear in the Data Granules field. 
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Figure 33. Q/A Monitor GUI - QRU Data Tab 
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15 In the Data Granules field, click on the granule to be checked. 

• It may be necessary to scroll through the list of granules. 

• The selected granule is highlighted. 

•	 Multiple granules may be selected. 

 Use the Ctrl key in conjunction with the mouse to highlight multiple granules. 

 	User the Shift key in conjunction with the arrow keys to highlight multiple 
granules. 

• Alternatively, the Find field and button may be used for specifying a data granule. 

 The Find field is case-sensitive. 

16 Click on the Retrieve Data Granule button. 

• Be patient; it will probably take some time for the selected files to be downloaded. 

17 Click on the Visualize data tab. 

• The Q/A Monitor GUI Visualize data tab (Figure 34) is displayed. 

• The Filter field (uneditable) contains the default configuration directory/file path. 

• The default configuration directory/file path is /var/tmp/*. 

•	 If you retrieve one type of files then retrieve a second type of files, the list of files 
retrieved expands. You should clean out the directory using UNIX commands to 
prevent the directory size (list of files) from becoming too great. 

18 In the Files field click on the name of the file to be checked. 

• The selected file name is displayed in the Selection field. 

19 Click on the Visualize button 

• Be patient; it will probably take some time for the selected file to be displayed. 

20 Review the image, checking the Operational QA Parameters of the image. 

• Verify that processing has actually resulted in an image. 

•	 If there is no image, it is necessary to investigate why processing failed and 
subsequently reprocess the PGE. 

21 Click on the QRU data tab. 

• The product Q/A Monitor GUI QRU data tab is displayed. 

22 In the Data Granule field click on the granule that was reviewed. 

23 Click on the Update MetaFile button. 

• The Q/A Monitor GUI Update Meta Data dialog box (Figure 35) is displayed. 
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Figure 34. Q/A Monitor GUI - Visualize Data Tab 
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N/A 

Figure 35. Q/A Monitor GUI - Update Meta Data Window 

24	 Click on the Operational Quality Flag option button to display a menu of operational 
quality flags. 

•	 The following menu of QA options is displayed: 

 N/A. 

 passed. 

 failed. 

 being investigated. 

 not being investigated. 

25 Click on the appropriate QA parameter. 

• Selected code is displayed on the Operational Quality Flag option button. 

26 Click on the OK button to set the flag and close the Update Meta Data dialog box. 

27 Repeat steps as necessary to review additional granules/files. 

28 Select File → Quit from the pull-down menu to exit from the Q/A Monitor GUI. 
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Reviewing Science Product History 
Reviewing science product history involves getting access to and inspecting data granule 
production history files. Both the Q/A Monitor GUI and UNIX command shells are used in 
gaining access to the history files. 

The procedure for reviewing science product history starts with the assumption that the 
Production Monitor has logged in to the ECS system. 

Reviewing Science Product History 

1	 Launch the Q/A Monitor GUI and select the data granule to be reviewed as described in 
Steps 1 through 16 of the procedure for Performing Science Product Quality 
Assurance (QA). 

• The product Q/A Monitor GUI QRU data tab (Figure 33) is displayed. 

• The appropriate granule in the Data Granules field is highlighted. 

2 Click on the Retrieve Prod History button. 

• Be patient; it will probably take some time for the retrieval to occur. 

3 Click in the UNIX (Terminal) window. 

NOTE: Commands in Steps 4 through 6 are typed at a UNIX system prompt. 

4 Type cd /path then press Return/Enter. 

•	 Change directory to the main granule history data directory (e.g., 
/net/sprn2sgi/imf_data/archive). 

• The directory path is embedded in the UR for the data granule. 

5 Type cd datatype then press Return/Enter. 

• Change directory to that of the desired data type. 

6 Type more filename.met then press Return/Enter. 

• Displays the metadata for the specified file. 

7 Repeat steps as necessary to review additional data granule production history files. 

8	 When all desired data granule production history files have been reviewed, click on the 
Q/A Monitor GUI to reactivate it. 

9 Select File → Quit from the pull-down menu to exit from the Q/A Monitor GUI. 
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Practical Exercise�

Introduction 

This exercise is designed to give the students practice in production planning and processing 
activities. 

Equipment and Materials 

One ECS workstation per student. 

Statement of the requirements for the exercise. 

Mission Operation Procedures for the ECS Project, 611-CD-002-001, one copy per student. 

Release A Operations Tools Manual, 609-CD-002-001, one copy per student. 

Creating a New Production Request 
The exercise involves the preparation of a new production request. The exercise begins with a 
student acting in the role of Production Planner receiving the necessary information/requirements 
for creating a new production request. The student prepares a new production request that is 
consistent with the requirements. 

Perform the following steps: 

1. Access the Production Request Editor. 

2. Prepare a new production request that is consistent with the written or stated requirements. 

3. Save the new production request. 

Editing/Modifying a Production Request 
The exercise requires the editing of a production request. The exercise begins with a student 
acting in the role of Production Planner receiving the necessary information/requirements for 
editing an existing production request. The student modifies the production request consistent 
with the requirements. 

Perform the following steps: 

1. Access the Production Request Editor. 

2. Select the Production Request to be modified. 

3. Make production request modifications consistent with the written or stated requirements. 

4. Save the modified production request. 
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Creating a New Production Plan 
The exercise involves the preparation of a new production plan. The exercise begins with a 
student acting in the role of Production Planner receiving the necessary information/requirements 
for creating a new production plan. The student prepares a new production plan that is consistent 
with the requirements. 

Perform the following steps: 

1. Access the Planning Workbench. 

2. Prepare a new production plan that is consistent with the written or stated requirements. 

3. Save the new production plan. 

Reviewing Data Processing Requests 
The exercise involves reviewing data processing requests. The exercise begins with a student 
acting in the role of Production Planner being directed to review specific data processing 
requests to determine specified characteristics. The student reviews the data processing requests 
consistent with the requirements. 

Perform the following steps: 

[TBD] 

Reviewing a Plan Timeline 
The exercise involves reviewing a production plan timeline. The exercise begins with a student 
acting in the role of Production Planner receiving the necessary information/requirements for 
reviewing a production plan timeline. The student reviews the specified production plan timeline 
and responds to questions concerning timeline characteristics. 

Perform the following steps: 

[TBD] 

Configuring AutoSys Runtime Options 
The exercise involves the configuration of AutoSys runtime options. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for configuring AutoSys runtime options. The student configures AutoSys 
consistent with the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access the AutoSys functions specified in the written or stated requirements. 

3. Select the AutoSys runtime options specified in the written or stated requirements. 

4. Apply the AutoSys runtime options specified in the written or stated requirements. 
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Configuring Hardware Groups 
The exercise involves the configuration of AutoSys hardware groups. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for configuring AutoSys hardware groups. The student configures AutoSys 
consistent with the requirements. 

Perform the following steps: 

1. Access the AutoSys group definition function. 

2. Enter the hardware groups specified in the written or stated requirements. 

3. Launch AutoSys. 

4. Review the hardware groups. 

5. Apply the AutoSys hardware groups specified in the written or stated requirements. 

Reviewing Hardware Status and Changing Hardware Status Views 
The exercise involves reviewing hardware status (including changing hardware status views) 
using AutoSys. The exercise begins with a student acting in the role of Production Monitor 
receiving the necessary information/ requirements for reviewing hardware status using AutoSys. 
The student reviews hardware status using AutoSys as specified in the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access HostScape. 

3. Review hardware status as specified in the written or stated requirements. 

4. Change hardware status views as specified in the written or stated requirements. 

5. Exit from HostScape. 

Reviewing DPR Dependencies 
The exercise involves reviewing DPR dependencies. The exercise begins with a student acting 
in the role of Production Monitor receiving the necessary information/ requirements for 
reviewing DPR dependencies. The student reviews DPR dependencies as specified in the 
requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access JobScape. 

3. Review DPR dependencies as specified in the written or stated requirements. 

4. Exit from JobScape. 
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Reviewing the DPR Production Timeline 
The exercise involves reviewing the DPR production timeline. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing the DPR production timeline. The student reviews the DPR 
production timeline as specified in the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access TimeScape. 

3. Review the DPR production timeline as specified in the written or stated requirements. 

4. Exit from TimeScape. 

Reviewing Alarms and Configuring Alarm Selection 
The exercise involves reviewing and configuring AutoSys alarms. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing and configuring AutoSys alarms. The student reviews and 
configures AutoSys alarms as specified in the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access the Alarm Manager through the Ops Console. 

3. Review and configure alarms as specified in the written or stated requirements. 

4. Exit from the AutoSys Alarm Manager. 

Reviewing Job Activities and Job Selection Criteria 
The exercise involves reviewing job activities and job selection criteria using AutoSys. The 
exercise begins with a student acting in the role of Production Monitor receiving the necessary 
information/ requirements for reviewing job activities and job selection criteria using AutoSys. 
The student reviews job activities and job selection criteria using AutoSys as specified in the 
requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access the AutoSys Job Activity Console. 

3. Review job activities as specified in the written or stated requirements. 

4. Review job selection criteria as specified in the written or stated requirements. 

5. Exit from the AutoSys Job Activity Console. 
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Modifying Job Priority 
The exercise involves modifying job priority using AutoSys. The exercise begins with a student 
acting in the role of Production Monitor receiving the necessary information/ requirements for 
modifying job priority using AutoSys. The student modifies job priority using AutoSys as 
specified in the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access the AutoSys Job Definition Advanced Features graphical user interface (GUI). 

3. Modify the job Que Priority as specified in the written or stated requirements. 

4. 	 Exit from the AutoSys Job Definition Advanced Features GUI, the Job Definition GUI and 
the Auto JAC GUI. 

Modifying Job Status 
The exercise involves modifying job status using AutoSys. The exercise begins with a student 
acting in the role of Production Monitor receiving the necessary information/ requirements for 
modifying job status using AutoSys. The student modifies job status using AutoSys as specified 
in the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access the AutoSys Send Event GUI through the Ops Console and the Job Activity Console. 

3. Modify the job status as specified in the written or stated requirements. 

4. Exit from the AutoSys Send Event GUI. 

Reviewing Activity Logs and Job Dependency Logs 
The exercise involves reviewing activity logs and job dependency logs. The exercise begins 
with a student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing activity logs and job dependency logs. The student reviews an 
activity log and a job dependency log as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 

2. Type the appropriate command for an activity log as specified in the requirements. 

3. Review the activity log. 

4. Type the appropriate command for a job dependency log as specified in the requirements. 

5. Review the job dependency log. 
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Generating Standard Production Reports 
The exercise involves generating standard production reports. The exercise begins with a student 
acting in the role of Production Planner receiving the necessary information/requirements for 
generating standard production reports. The student generates standard production reports as 
specified in the requirements. 

Perform the following steps: 

1. Launch the Production Request Editor. 

2. Access the Report Generator GUI. 

3. Generate the standard production reports specified in the requirements. 

4. Exit from the Report Generator GUI. 

Generating AutoSys Reports 
The exercise involves generating AutoSys reports. The exercise begins with a student acting in 
the role of Production Planner receiving the necessary information/requirements for generating 
AutoSys reports. The student generates AutoSys reports as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 

2. Type the command line for generating the AutoSys reports specified in the requirements. 

Defining and Running Monitors/Browsers 
The exercise involves defining and running monitors/browsers. The exercise begins with a 
student acting in the role of Production Planner receiving the necessary information/requirements 
for defining and running monitors/browsers. The student defines and runs monitors/browsers as 
specified in the requirements. 

Perform the following steps: 

1. Launch AutoSys. 

2. Access the Monitor/Browser GUI. 

3. Define monitors/browsers as specified in the requirements. 

4. Save the monitors/browsers. 

5. Run the monitors/browsers. 

Changing the Database Maintenance Time 
The exercise involves changing the database maintenance time. The exercise begins with a 
student acting in the role of Production Monitor receiving the necessary information/ 
requirements for changing the database maintenance time. The student changes the database 
maintenance time as specified in the requirements. 
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Perform the following steps: 

1. Access the command shell. 

2. Change the database maintenance time. 

3. Save the modified configuration file. 

Performing Science Product Quality Assurance (QA) 
The exercise involves checking a data granule to verify the output of data processing. The 
exercise begins with a student acting in the role of Production Monitor receiving the necessary 
information/ requirements for performing science product quality assurance (QA). The student 
performs science product QA as specified in the requirements. 

Perform the following steps: 

1. Launch the Q/A Monitor GUI. 

2. Check the specified granule to determine whether it contains an appropriate image. 

3. 	 Set the operational quality flag to the appropriate value based on the evaluation of the 
granule. 

4. Exit from the Q/A Monitor GUI. 

Reviewing Science Product History 
The exercise involves reviewing a data granule production history file. The exercise begins with 
a student acting in the role of Production Monitor receiving the necessary information/ 
requirements for reviewing a data granule production history file. The student performs the 
procedure as specified in the requirements. 

Perform the following steps: 

1. Launch the Q/A Monitor GUI. 

2. Specify a granule to be reviewed. 

3. Retrieve product history. 

4. Access the command shell. 

5. Access/display the metadata file for the data granule. 

6. Exit from the Q/A Monitor GUI. 
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Slide Presentation


Slide Presentation Description 
The following slide presentation represents the slides used by the instructor during the conduct of 
this lesson. 
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